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Preface

Computer

: Computers, a series of eight books, is a carefully arranged Computer series,

that perfectly complies with the NCERT syllabus criteria and the National
Curriculum Framework's vision. In auordance with NEP 2020’s guidelines,
the series adopts an interactive approach to make Learning about
Computer enjoyable for students. This book includes enough questions in
accordance with the NEP criteria. The fundamental principles of NEP which
are recognising, identifying and fostering the unique capabilities of each
student, respect for diversity, and respect for the local context in all topics,
are always kept in mind while creating the book.

The topics are introduced in a way that children experience and learn
through exploration.

Child-friendly language and contextual images have been incorporated
throughout the series to make the material more understandable for young
readers. This allows them to connect what they read and relate it to the
views, ideas and experiences they encounter every day.

Salient Features of the series:

Learning Outcomes

Warm Up
Teacher’s note
Let me answer

Do You know
Remember It

Kids’ IQ

Up skill your
Intelligence
Critical Thinking

Team Work

It shows the right path of learning to the teachers as well as students. It
establishes the direction of learning for efficient and superior learning
results.

: Children can connect their prior knowledge to the chapter's topic through

simple yet engaging activities.

: An outline of guidelines for teachers to follow in the classroom in order to

make lessons interactive and discussion-based.

: Questivns related to the topic which are essential for checking pupil

understanding and keeping them engaged with the task at hand.

: An interesfing piece of information related to the topic.

: Additional information about the topic to encourage children to wonder

about various surroundings.

: These questions have been included to reinforce learners to think, analyse

and apply.

: Ample exercises with a range of questions to support learning.

: Questions which allow the learners to think clearly and rationally. Further,

permit the learners to understand the logical connections between ideas in
order to analyse facts and come to a conclusion.

It enables the students to collaborate with others.

The content is structured and well-graded. Sincere efforts have been taken to prevent any
inconsistencies and make this series a perfect complement to the students' education. Any worthwhile
recommendations for how to improve the series are always welcome and greatly appreciated.

Author
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GENERATIONS OF COMPUTERS

Lo], WIcaninojoutcomes

At the end of this chapter, students will be able to:

+ Know the characteristic features of different generations of computers.
+ Learn about the Primary and Secondary memory of a computer.

Circle the pictures of the things that were used by your ancestors.

‘¥ Teacher’s Apprise students that with every passing generation, progress takes place that makes our
life better.

Q\J‘ Note:
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Hey Friends! Lets learn about
different generations of computers.

In today’s world, for almost every activity whether personal or business-
related; in some or other way, we rely on the computer system. It's amazing
how easily computers operate, in terms of speed, accuracy and readiness.
As a result of their high-speed processors and data storage devices, modern
computers are more potent than earlier models which were only meant to be
used for calculations. Since ancient times, simple manual machines like the
Abacus helped people in doing calculations.

In 1833, Charles Babbage who is referred to as the ‘Father of Computers’
invented the machine called Analytical Engine. It was the first-ever working
model of a mechanical computer, whose structure is considered the basic
framework of modern-day computers today.

GENERATIONS OF COMPUTERS

The technology employed changes with each generation. The modern-day
computer is the result of changes that took place over a period of time. There
are five generations of computers.

[ Generation of Computers )

4

l Y y i

[ First Generation ] Second Generation [Third Generation] [Fourth GenerationJ Fifth Generation

Figure 1.1: Timeline

First Generation of Computers (1940 - 1956)

The features of the first generation computers were:

These computers were huge in size.
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The calculations were carried out
using circuitry made of vacuum
tubes.

+ They used a lot of electricity and
produced a lot of heat.

They used punched cards for the

communication of data.
Examples: Mark I, ENIAC and UNIVAC.

Figure 1.2: First Generation Computers

Second Generation of Computers (1956 - 1963)

In this generation, assembly language s
and high-level programming languages <% Do You Know?
like FORTRAN and COBOL were used. Similar to modern-day electric bulbs,

. vacuum tubes existed. They used to fuse
The computers used batch processingand | qularly and produced a lot of heat.

a multip rogramming oper ating system. The UNIVAC had 5200 vacuum tubes.
Storage media such as tape, disk and

printers were in use for the output.

The features of the second generation
computers were:

They were a bit large but smaller, cheaper and
faster than the first generation computers.

+ In order to perform the calculations, they

: : i .3: ist
used transistors instead of vacuum tubes. Figure 1.3: Transistor

Magnetic tapes were used to store | -
data. Fys

+ In this generation, the use of the
keyboard as an input device was
also introduced.

Examples: IBM 1620, IBM 7094 and
UNIVAC 1108.

Figure 1.4: Second Generation of Computer
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Third Generation of Computers ( 1964 - 1971 )

Integrated circuits were developed in the third
generation, which resulted in smaller-sized computers
with better performance and more storage.

The main features of the third-generation computers

Figure 1.5: Integrated
were:

circuit chips
They used integrated circuits, which

reduced the size and increased the speed

of the computers.

+ They were more affordable and efficient
than second-generation computers.

Monitors and keyboards were used for

communication. , _
Figure 1.6: Third

Examples: Honeywell 6000 series, IBM system Generation of Computer
360 and UNIVAC 9000 series.

Fourth Generation of Computers ( 1972 - 1981 )

%27 Let Me Answer The invention of Very
Who comes in the four th? Large Scale Integration
generation in your family (VLSI) came into existence
in which thousands of transistors were on a single Figure 1.7: VLSIC
chip called a microprocessor.

The main features of the fourth-generation
computers were:

+ 'The size of the computers was reduced to
what we call a Personal Computer.

The speed of the computers were increased
and the cost was reduced.

+ GUI operating system was introduced.
Figure 1.8: Fourth

Examples: DEC 10, CRAY 2 and Apple II. Generation of Computer
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Fifth Generation of Computers ( 1982 - Present)

In the fifth generation, VLSI technology —-—
became ULSI (Ultra Large Scale Integration)

The first Microprocessor was
technology. The devices are equipped with | created by Intel.

Al-based technologies like face detectors,
fingerprint detectors and much more.

The main features of the fifth-generation computers are:
+ 'The size, cost, speed are improved with high performance.
+ Development of new versions of GUI Operating systems.

+ 'The computers can recognise a human face, fingerprints and voice.

Examples: Notebooks from IBM and Robots.

The two key factors that have accelerated the development of different
generations are processing speed and storage capacity. It is important for us
to know about computer memory and its types.

COMPUTER MEMORY AND ITS TYPES

Computer memory refers to the storage area of a computer where all the

data and instructions are stored.

{ Computer Memory J—

Primary (Internal) Memor Secondary (External) Memor
y y Y y

|
| | | |
@—4@ [ Hard Disk J {Blu Ray Disk] [ CD/DVD ] [Flash Drive]

[SRAM DRAM] [PROM] [EPROM ] (EEPROM]

Figure 1.9: Computer Memory
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PRIMARY MEMORY

Primary Memory is a section of computer memory that the CPU can access
directly, also called Main memory or Internal memory. It has constrained
capacity. We can broadly classify Primary Memory into two parts:

1. Read Only Memory or ROM
2. Random Access Memory or RAM

Read Only Memory or ROM

As the name suggests, we can only read from this
memory and cannot write on it. It is the built-in
memory of a computer. Moreover, it does not lose
data after the power supply is cut off i.e. it is non-
volatile. Furthermore, its main function is to store
the program and instructions permanently. Figure 1.10: ROM

ROM is of three types:

PROM:  The user can only change the programmable Read Only
Memory once.

EPROM: Itis Erasable Programmable Read Only Memory which can
be erased as well as reprogrammed.

EEPROM: The Electrically Erasable Programmable Read Only
Memory can be modified by erasing the content and
reprogrammed.

Random Access Memory or RAM

Random Access Memory
is a type of computer
memory that can be read
and modified in any
order. It is usually used

to store working data and
Figure 1.11: RAM
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machine code. The storage of data and instructions are temporary. It is
volatile memory, i.e. When the power is cut off, it loses its content.

We can broadly classify RAM into two types on the basis of behaviour:

SRAM:  Aslong as the computer is powered on, the data is kept in
static RAM (SRAM).

DRAM:  This memory is temporary and constantly refreshes its
content.

SECONDARY MEMORY

Secondary Memory stores a large amount of information permanently, i.e.,
it doesn't lose its memory when the power is off. It is also called External
Memory. Some of the secondary storage devices are Hard Disk, CD-ROM,
Digital Versatile Disc, Blu ray Disc and Pen Drive.

Hard Disk:

Hard disks are storage devices designed to hold a

lot of information. It is the main and the largest

secondary data storage device in a computer. Hard

disk stores the operating system, software and other

files. It is created using the collection of discs known

as platters. The platters are placed one below the  pigyre 112 Hard Disk
other. They are coated with magnetic material.

CD-ROM ( Compact Disc-Read Only Memory)

It is an optical storage device that has the capacity to
hold a wide range of data in the form of text, photos,
video and audio. The storage capacity of a CD is up to
700 MB of data. Its shape is circular and is made up of
polycarbonate plastic. Figure 1.13: CD-ROM
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DVD ( Digital Versatile Disc)

A Digital Versatile Disc, usually known as a DVD,
resembles a CD in appearance but has a larger storage
capacity, holding up to 4.7 GB of data.

Blu-Ray Disc Figure 1.14: DVD

A Blu-ray disc looks just like a CD or a DVD but it
can store data or information up to 25 GB data. It is
developed for recording, rewriting and playing high-
definition video. The name Blu-ray is derived from the
technology that is used to read the disc ‘Blu’ from the
blue-violet laser and ‘ray’ from an optical ray.

Figure 1.15: Blu-Ray Disc

Pen Drive

A pen drive is a small device, which is used to transfer
and store data. It is also called a USB drive or Flash

drive. It comes in various storage capacities, such as
1 GB, 2 GB, 4 GB, 8 GB, 16 GB, 32 GB, 64 GB, up to , _
Figure 1.16: Pen Drive

1 TB. -
'ﬁh Let me Answer
For what purpose have you used a pen drive?

= Kids’ 1Q
)

List the names of the brands which make pen drives.

@ Let’s Recall

There are five generations of computers.
First generation computers used punched cards for the communication of data.
« Inthesecond generation, the use of the keyboard as an input device was also introduced.
o In the fourth generation, GUI operating system was introduced.
e Primary Memory is also referred to as Main Memory.

« Secondary Memory is also referred to as External Memory.
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# Upskill Your Intellige

A. Fill in the blanks.

1. In ancient times, simple manual machines like .................... helped people in

doing calculations.

20 e, is referred to as the Father of Computers.

3. was the first-ever working model of a mechanical computer.
4. Thereare .................. generations of computers.

5. s circuits were developed in the third generation.

B. Write ‘T’ for True statements and ‘F’ for False statements.
1. Computers of the first generation were small in size.
2. Magnetic tapes were used in the second-generation
computers to store data.
3. IBM system 360 is an example of a third-generation computer.
4. In the fifth generation of computers, VLSI came into existence.

5. ULSI stands for Uniform Large Scale Integration.

oudu O

C. Answer in one word.
1. A type of computer memory that can be read and modified in any order.
2. A secondary storage device which resembles a CD in appearance but has a
larger storage capacity.
3. A storage device that is also referred to as a USB drive or Flash drive.
The memory which is temporary and constantly refreshes its content.

5. A storage device made up of Polycarbonate plastics.

D. Write the following in expanded form.
Lo ROM -
2. RAM-
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3. CD-ROM-
4. DV -
5. VLS I

E. Answer the following questions.

1. How many generations of computers are there?

3. State the difference between the third generation and fourth generation of

computers.

ooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooo

ooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooo

ooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooo

' }\ Gritical Thinking

E ]

A. Some features have been listed on the next page. Segregate them in the
appropriate columns.
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< GUI operating system was introduced.

< Usage of Integrated Circuits.

< Magnetic tapes were used to store data.

< Punched Cards for the communication of data.

< The use of the keyboard as an input device was introduced.

Second
Generation

First
Generation

Third
Generation

Fifth
Generation

Fourth
Generation

B. Samaksh attended the marriage ceremony of his cousin. He wants to save all

the pictures but the file is larger than 16GB. Advise him as to what should he

Team Work

Let us discuss the topic - Generation of Computers.

Which generation of computer do
you use? How?
L
2t
G
4.
o

Which types of secondery storage do
you use? List the name of the devices.
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LEARNING MORE ABOUT
WINDOWS 10

At the end of this chapter, students will be able to:

+ Know various features of Windows 10.

+ Enhance their knowledge of various components of Windows.
+ Change Windows appearance.

Number the following Windows from the older versions to the advanced editions.

Windows 7 D Windows 10 D Windows XP D

Windows 2003 D Windows VISTA D Windows NT D

‘W Teacher’s AL students in arranging the editions of the windows in chronological order. Apprise
g\ (TR  students that continuous research and increased technology usage has led to the advanced
editions of Windows by Microsoft.
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Hi Friends! In the previous class,
we already learnt about some of
the features of Windows 10. Lets
learn more!

As we know, a computer is a machine that cannot think on its own and
requires commands from us. The most important program of a computer
is its Operating System. Windows is such an operating system that acts
as a medium through which we can interact with the hardware, using the
software.

The first GUI edition of windows with a new user interface was introduced
in 1995 and was called Windows 95.

Windows 10 is the latest version of Windows available in the market.

FEATURES OF WINDOWS 10

Following are the features of Windows 10.

9

<% Do You Know?
It is interesting and easy to use. Bill Gates is the founder of Microsoft.

It is the most secured version of windows.

The use of graphics makes it quite interactive.

The enhanced tool, Cortana, allows in searching the information on the
system or the web directly.

The new start menu helps to
give us easy access to apps and
services.

The new Task View button on
the taskbar provides the ability
to open multiple desktops at the
same time. You can create an

unlimited number of desktops. , ,
Figure 2.1: Window 10
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The window snapping feature allows working with multiple applications
on the screen.

Microsoft Edge is the default browser of Windows 10. It helps you to
write and highlight directly on the web pages.

With Windows Hello, you can instantly access your Windows 10 devices
using a PIN, facial recognition software, or a fingerprint in a more private
and secure way.

The window store provides a lot of free or paid applications.

COMPONENTS OF WINDOWS 10 @ Let Me Answer
What all files do you have
Components of Windows 10 on your desktop?

Desktop

The first screen that appears when
we start the computer is called the
Desktop. It has various icons of files
and folders. By default, the taskbar
is located at the bottom of the
desktop screen.

Figure 2.2: Desktop

Icons

Icons are tiny images on the desktop that represent files, folders, and apps.
Some of the common desktop icons include: This PC, Application icons,
shortcut icons and recycle bin.

B X
O

LET US LEARN ABOUT THESE ICONS IN DETAIL

This PC Icon:

It shows all the files and folders stored on our computer
system. It helps us in ordering the data stored on the local

drives efficiently. Figure 2.3:
This PC icon
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2. Application Icons:

To display a specific application on a
computer, windows employ application
icons. It provides easy access to the

related application. , o
Figure 2.4: Application Icons

3. Shortcut Icons:

A shortcut icon

What do you mean by
provides direct a shortcut?

access to a certain

e . ) Figure 2.5: Shortcut Icon
application. It has a small arrow on its lower left.

4. Recycle Bin Icon:

All the deleted files/folders are moved into the
Recycle bin. We can easily restore the file or a folder
from recycle bin or can be deleted permanently. Figure 2.6: Recycle bin

Start Button

Itisatthe bottom left of the screen. By
clicking on it, we get two panels side
by side. The panel on the left displays
apps in a listed form in alphabetical
order. Live titles which show the new

updates are on the right panel.
Figure 2.7: Recycle bin

Taskbar
The long horizontal bar found at the desktops bottom is the taskbar.
Start button Open and pinned programmes Time and date
Cortana, Run and Search Notification Area

Figure 2.8: Windows Taskbar
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It shows the Start button on the extreme left side. Just next to the Start
button is the search box, Cortana. It helps to browse both your computer
and the web. To the right of the Cortana, is the Task view button which
allows accessing multiple desktops simultaneously. The area which lies
in the mid of the taskbar contains the apps which are opened and are
used frequently. In the taskbar, we have a notification area on the right
side, which shows the clock, date, and some more icons. On the extreme
right, the Peek button is present which makes the desktop visible by
minimizing all the open windows.

CUSTOMISING WINDOW APPEARANCE

With the wide range of settings in Windows 10, we can change the appearance
to make the desktop and apps look better.

Changing the wallpaper

Follow the following steps to change the wallpaper.

Steps:

1.

2
3.
4.
5

|
N

Right-click on the blank area of the desktop.

From the pop-up menu, select the Personalize option.

The settings window will be displayed.

Under the Personalisation panel, click on the background option.

Select the
background
available or click
on the browse
button to select
the picture of
your choice.

The selected

picture will be

set as the desktop

background. Figure 2.9: Background
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Setting the Screen Saver

A screensaver is a computer program that displays the black screen or fills
it with moving patterns when the computer has been idle for a designated
time.

Follow the following steps to change the B

Press window Key + L together to

SCreen saver.

Steps:
Right-click on the blank area of the desktop.

From the pop-up menu, select the Personalize option.

1.

2
3.
4.
5

The settings window will be displayed.

lock your computer.

Select the Lock screen option from the left panel.

Click on the screen saver
option, and a dialogue
box will appear.

Select the desired Screen
saver and click on the
apply option.

The chosen screen saver

will be applied.

Live Tiles

In the right panel of the Start Menu, the
most popular Universal apps in the form
of resizable live tiles are displayed. All the
latest information such as news, weather
report and much more are shown here.

Follow the following steps to resize a live tile.

Steps:

1.
2.

Click on the Start menu.

Figure 2.10: Lock Screen

Figure 2.11: Live Tiles

Right-click on the tile whose size you want to change.
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3. Select the option Resize, and choose the size of your choice from the
sub-menu.

Turning a Live Tile On/Off

Follow the following steps to turn on Live tiles.

Steps:
1. Click on the Start
menu.

2. Right-click on the tile
you want to turn on.

3. Click on more, and
click Turn live tile on.

Similarly, you can turn off
the Live title by selecting

Turn Live title off. Figure 2.12: Turning a Live Tile On/Oft

Displaying Windows Together
Multiple application windows can be displayed side by side in Windows 10.
Follow the following steps to display windows together.

Steps:
1. Open Excel window, Word
window and Paint 3D.

2. Now, Right-click on the
blank area of the taskbar.

3. Select the ‘Show Windows
Side by Side’ option from
the pop-up menu.

4. All three windows will be
displayed side by side.

Figure 2.13: Displaying Multiple Windows Together
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FILE EXPLORER WINDOW

Files and Folders stored in our system are displayed in the File Explorer
Window. It allows to view and manage files and folders. Further, we can
create, open, move or delete a folder in this window.

Opening File Explorer

Follow the following steps to open the File Explorer window.
Steps:

1. Click on the Start button.

2. Click on the File Explorer option.

3. 'The File Explorer Window will open.

4. Alternatively, click the Windows button (Windows button) + E.

Components of File Explorer Window

1. Search Box: In this
box, we can search
files or folders in the
system.

2. Navigation Pane: It
is on the left and is
used to explore disks
and drives. Figure 2.14: File Explorer

3. Content Area: It contains icons representing the drives in the system.

4. Address Bar: Here, the path of the currently open file or the folder is
displayed.

UNIVERSAL APPS OF WINDOWS 10

Universal App is an application that works on all devices from phones to
high-powered desktops. Moreover, these apps can work on different types of
devices such as iPhones and Smartwatches.
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Some of the most useful apps are:

+ Weather App - This app lets you know all
about the Weather such as real-time rain
alerts, minimum/maximum temperature and
much more.

<« E-mail App - This app aids you to manage all
your mail accounts in one place. Also, it gives
the notification of all the incoming mails.

+ News App - This application displays the
latest news to keep the user up-to-date.

Figure 2.15: Weather App

s Kids’ 1Q

Pragya is a content writer . She has to keep herself updated with the news every hour.
Suggest the kind of app she should use for the same.

! Let’s Recall

The most important program of a computer is its Operating System.
o The first screen that appears when we start the computer is called the Desktop.
o All the deleted files/folders are moved into the Recycle bin.
o The long horizontal bar found at the desktop’s bottom is the taskbar.
o Files and Folders stored in our system are displayed in the File Explorer Window.

o Universal App is an application that works on all devices from phones to high-
powered desktops.

K X Computer-5 f-xx ¢ X XEER XXE X XW=
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A. Fill in the blanks.
1. 'The most important program of a computer is its ....................

2. The first GUI edition of Windows with a new user was introduced in

K S is the latest version of windows available in the market.
4. 'The Window store provides a lot of free or paid .....................
5. The first screen that appears when we start the computer is called the ................

B. Answer in one word.

1. Tiny images on the desktop that represent files, folders and apps.

C. Write ‘T’ for True statements and ‘F for False statements.
1. A computer is a machine that thinks on its own. D
2. 'The first GUI edition of Windows was called Windows 95. D
3. Bill Gates is the founder of Microsoft. D
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4. In Windows 10, we can create an unlimited number of desktops. D
5. All deleted files/folders are moved into This PC. D

D. Identify the following icons/apps and write their names.

E. Answer the following questions.

1. Write any five features of Windows 10.

ooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooo

ooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooo
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4. What do you mean by a screen saver?

ooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooo

ooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooo

")\ Critical Thinking

A. Anushka wants to write the information from two different files. Suggest the
option she can use to open two files side by side.

B. Unscramble the letters to form words.
1. SLUIVNEAR PAP - .ot
2. VILEEILT - e
3. DTESKPO - e
4. SKBTAAR -
5. SNIOC-

A. Work in pairs. Find out an interesting quote on hard work by some famous
personality and set it as your wallpaper.
B. Discuss with your friends.
1. Which type of wallpaper do you like the most?
a. Nature b. Famous personalities c. 3D objects.

2. How did you write the quote?
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At the end of this chapter, students will be able to:
+ Apply the styling features in MS Word.

+ Insert symbols and shapes.

+ Set the page margins, size, orientation and colours.
+ How to use Thesaurus to improve vocabulary.

Can you make a friendship card? Here are some clues:

Ask your parents to allow you to use their computer and make a friendship card
to celebrate the friendship-day with your friends.

LU 002016,

Ehac"er,s With the help of the above activity, introduce the students to the advance features of MS-
S
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“Hi friends! Lets learn about
the advanced features of MS-
Word. 1t helps us to learn
various styling features.

Microsoft Word 2016 is the most popular word processor developed by
Microsoft Corporation. It is one of the world’s largest companies in software
development.

Word 2016 has the ability to create, read, edit and share files at once very
easily. Formatting can also be done in the documents.

Let’s further study the advanced features of MS Word 2016.

MS WORD STYLES

Styling is the process of altering the font’s appearance in terms of size, colour,
and themes. In MS Word, we can change the style of any text in a sentence
or paragraph.

. = Do You Know?

Using the ‘design a style’ option provided
in the styles drop-down list, you can
font style. build your own special styles.

We can use the styles options, which include
predetermined styles, to quickly change the

Styling features can be applied to the following elements:

Paragraph

The outlook of a paragraph can be changed completely by changing its
styling. A paragraph consists of different options like heading, quote, index,
header, footer, bibliography, salutation, address and much more.

Character

The smallest element in a word document is a character.
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Linked Content

Linked Content is a mix of paragraphs and characters. It has styles available

for both paragraphs and characters.

Table

@ Let Me Answer
What is a paragraph?

There are different table styles available such as Plane Table, Grid Table, List

Table, Colourful Grid and many more.

List

A list contains ordered and unordered list items.

Follow the following steps to apply styles to a Paragraph.

1. Select the desired paragraph.

2. In the Style group, click on
the more option.

3. A drop-down containing
different style options will
appear.

4. Place the cursor over the
desired Style.

5. Seethe changein the selected
text.

SUBSCRIPT

You must have observed TH after
some numbers like 2’ after some
letters in chemical formulas.
Denoting a number or letter above
or below the baseline makes it either
a Superscript or a Subscript.

Figure 3.1: Applying Styles

'@ Let Me Answer
Tell the chemical formula which
has a number as subscript.

Figure 3.2: Creating Subscript
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The subscript option places the selected text slightly below the baseline and
makes it appear smaller than the rest of the text.

Follow the following steps to create a Subscript.
1. Type the formula CO2 and select 2.
2. From the font group, select the subscript Option.

3. You will notice that 2’ will be placed below the baseline.

SUPERSCRIPT

The superscript option places the selected text slightly above the baseline
and makes it appear smaller than
the rest of the text.

Follow the following steps to create
a Superscript.

1. Type the date 10th April and
select th. Figure 3.3: Creating Superscript

2. From the font group, select the -_

superscript Option. By pressing Ctrl+Shift++ key combination,
you can create Superscript.

3. You will notice that ‘th’ will be
placed above the baseline.

INSERTING SYMBOLS

Symbols are special characters.

Follow the following steps to insert symbols.

1. Take the cursor to the point where you wish to insert the symbol.
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2. Go to the Symbols group in the
Insert tab, and select the symbol
button.

3. Pick a symbol of your choice or
choose the more symbols option.

4. When you find the symbol of your
choice, double-click on it.

5. 'The symbol will be inserted at the
desired place.

6. Click on the cancel button. Figure 3.4: Symbol

UNDO AND REDO COMMANDS

MS Word 2016 keeps the record of all the alterations that we doin a document.
The Undo command allows you to discard the most recent change. The Redo
command reverses the most recent change made using Undo. These buttons
appear in the Quick Access Toolbar in Microsoft by default.

Quick Access

Undo Button Redo Button
Toolbar

Design Layout

Figure 3.5: Quick Access Toolbar

Follow the following steps to undo the last action.

1. On the Quick Acess Toolbar, click Undo. Alternatively, you can press
Ctrl + Z.

2. Click the drop-down arrow next to Undo, if you want to undo several
actions at the same time.
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Follow the following steps to redo the last action.

On the Quick Acess Toolbar, click Redo. Alternatively, you can press Ctrl + Y.

PAGE SETTINGS

In Word, we have options for formatting
the page and also for setting the page
properties.

Setting Margins Figure 3.6: Page Margins

A margin is the amount of space between the text and the edge of the page.
The default margins are set at 1” from top and bottom and 1” from the left

and right edge of the page.

In Word 2016, we can manually set the margin on all four sides of a document.
Follow the following steps to set the Page Margins.

1. Click on the Layout tab.

2. In the Page Setup group, select the
Margins buttons.

3. Select the margin from the list or
customise it as per your requirement.

4. Type the values for Top, bottom, left
and right margins.

5. Inthe Apply to drop-down list, choose
the option : Whole document.

6. Click OK.
Figure 3.7: Page Setup
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Setting Paper Orientation

The property to set the
printing direction of

the text is called Page
Orientation. It is of

two types: Portrait and
Landscape Orientation.
The default orientation is

Portrait, which is vertical. Figure 3.8: Page Orientation

Follow the following steps to change paper orientation to landscape
(horizontal).

1. Click on the Layout tab.

2. In the Page Setup group, click on the Orientation button.

3. From the drop-down list, choose the landscape orientation.
4

The orientation of the page changes to Landscape.

Setting Page Size
) . H=-0 -
In Word 2016, different sizes
. ik [ Tone lizel, Chesign wal B S AT kailirs [itraien

of paper can be used to write a —— . )

LI:LI & | || = 1 Hroinke Indrr
document. B . | 7 Lire M - =Ll (O i

kargins Cnentatize] S Dinlames

3 o '\.- « B Hypheratine v == Rignt: |10 roe :
Follow the following steps to [ by : s
change the page size of the Word. Figure 3.9: Page Size

1. Click on Layout Tab.
In the Page Setup group, click on the size button.
A drop-down menu appears. The current page size is highlighted.

Select the desired page size option.

AR

The size of the page will change.
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WORKING WITH SHAPES

AutoShapes is a tool to help you draw

objects on your document. There are

many shapes such as lines, call-out,

equation shapes and many more.

Follow the following steps to insert a

shape in the document.

1.

2
3
4.
5
6

Click on the Insert tab.

Figure 3.10: Shapes

In the Illustration group, select the shapes button.

A drop-down menu will displayed.

Click on the desired shape.

The mouse pointer changes to (+) plus sign.

Take the plus sign to the desired place in the document and drag it to

add the shape.

Placing Text in a Shape

Text can also be inserted in the shape.

Follow the following steps to add text in a shape.

1.

Select the shape you
want to add text in.

Right-click on it.

A pop-menu appears,
select the Add text
option.

Figure 3.11: Placing Text in a Shape
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4. Now type the text

in the placeholder.
5. Click outside the

placeholder to

complete the task.

Figure 3.12: Typing Text in a Shape
THESAURUS ; yping i shap

Microsoft Word
includes a tool
that enables

you to perform
synonym and

antonyms Figure 3.13: Thesaurus
searches using the thesaurus. We can also look up for a suggestion of a
word.

Follow the following steps to use the Thesaurus.

1. Select the word for which you want a
synonym or antonym.

2. Click on the Review tab.
In the proofing group, select the Thesaurus
option.

4. 'The Research task pane appears with
synonyms and antonyms.

5. Choose the desired word and select the
Insert option.

6. 'The existing word will be changed with

the new word. Figure 3.14: Search for

Synonyms or Antonyms
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DROP CAP EFFECT

A drop cap (dropped capital) is a large capital letter used as a decorative
element at the beginning of a paragraph or section. The size of a drop cap is
usually two or more lines.

There are two types of Drop Cap:
Dropped option allows you to create a drop cap that fits within your paragraph.

In Margin option allows to create a drop cap that is in the margin, outside of
your paragraph.

Figure 3.15: Drop Cap Effect

Follow the following steps to apply Drop Cap Effect.

1. Select the first letter of a paragraph.

Click on the Insert Tab.

Select Drop Cap button and a drop-down menu appears.

Select either dropped or in margins as per your requirement.

oo B

Selected character will be changed.

HEADER AND FOOTER

Information is added to the top and bottom of each page using the header
and footer, respectively.
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Follow the following steps to add a header to your document.

1.

2.

5.

6.

7.

Click on the Insert tab.

In the Header
and Footer
group, select

the header

button.

A drop-down
menu appears,
select the
Blank option.

A p]aceho]der Figure 3.16: Adding Header
of the header will be displayed at the top margin of the document.

Click on the placeholder to add text.
In the close group, click on the close header and footer button.

Observe the top margin of the document.

Follow the following steps to add a footer to your document.

1.
2.

B X
O

Click on the Insert tab.

In the Header
and Footer
group, select
the footer
button.

A drop-down
menu appears,
select the

Blank option.
Figure 3.17: Adding Footer
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4. A placeholder of the footer will be displayed at the top margin of the
document.

5. Click on the placeholder to add text.
In the close group, click on the close header and footer button.

Observe the bottom margin of the document.

REMOVING HEADER OR FOOTER

From the header drop-down menu, select remove header to withdraw

header.

From the footer drop-down menu, select remove footer to withdraw
footer.

- s Kids’ 1Q

Harman is writing an article for her school magazine. She wants to use advanced
vocabulary. Suggest her ways for the same.

@ Let’s Recall

Microsoft Word 2016 is the most popular word processor developed by Microsoft
Corporation.

o Styling is the process of altering the fonts appearance in terms of size, colour and
themes.

o The subscript option places the selected text slightly below the baseline.
o A margin is the amount of space between the text and the edge of the page.
« AutoShapes is a tool to help you draw objects on your document.

« Information is added to the top and bottom of each page using the header and
footer, respectively.
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# Upskill Your Intellige

A. Fill in the blanks.

1. Microsoft word is the word processor developed by .....................

2. 'The smallest element in a word documentisa .....................
3. Linked contentisa mix of .................... and ...l

4. Alistcontains .................... and .........o......... list items.
5

The Subscript option places the selected text slightly ........................ the
baseline.

B. Answer in one word.

1. The process of altering the appearance of font in terms of size, colour and
themes.

C. Write ‘T’ for True statements and ‘F’ for False statements.
1. The outlook of a paragraph cannot be changed.

2. 'The Redo command reverses the most recent change made using
Undo.

3. Press Ctrl + U to apply Undo Command.

4. A margin is the amount of space between the text and the edge
of the page.

5. 'The default page orientation is landscape, which is horizontal. D
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D. Tick (V') the correct answer.

1.

In the word, ..........c.o..... helps us look up for a suggestion of a word.

() a. Header () b. Footer

() c. Thesaurus () d. Drop Cap effect

A tool that help you draw objects on your document.

() a. Font () b. Shapes () c.Symbols [ ] d. Margins
Page size can be changed by clickingon .................... tab.

() a.File () b. Insert () c. Design () d. Layout
Dropped and In Margins are two options of ....................

() a. Margins () b. Drop Cap Effect

() c. Paragraph () d. Insert

The information which is added to the bottom of each page.

() a. Header () b. Footer () c.Symbols [ ] d. Shapes

E. Answer the following questions.

1.

Write the steps to apply styles to a Paragraph.

ooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooo

ooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooo
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Critical Thinking

A. Find the group names in the grid where the following options can be found.

1. Page Margins - ...

2. Symbols -

3. Thesaurus - e,

4. Shapes-
D Q J W E D R T Y U P 1 P
X A S P D F G P H I U J R
A S p F G J H I J H T K @)
Y Q W  E R T D W  E R | E T I
S D F G H J K J L I S H S
A Z X C \Y B N M H I E J L
A S D P R O O F I N G G O
p Z D X C C H \Y B N A N B
A P S D F G P H J K P L M
A P D J Q W E R T Y F E Y
I L L U S T R A T I O N S

B. A book publishing house wants to write the name of their company at the
bottom of every page. Suggest the ways to do so.

Team Work

A. Collect information on photosynthesis and make a project in MS-Word.

B. Write the equation of photosynthesis using subscripts.

B X
O
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MAIL MERGE

At the end of this chapter, students will be able to:
+ Know the features of Mail Merge.

+ Merge the components of the Mail Merge.

+ View and print the Merged Data.

Shubham has recently adopted a puppy. He wants to throw a party for its
homecoming. To invite his friends, he has written a letter in MS Word 2016.
Now, he wants to send the same letter to his 15 friends. Discuss the ways he can
do the same without taking much time.

‘W Teacher’s With the help of the above activity, introduce the students to the mail merge feature of
[ A0 Word 2016.
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“Hello friends! Lets learn about the
Mail Merge features 2016. It saves
our time and efforts to send letters at
multiple addresses.

Your school sends the same circulars to all the students from classes 1-12
on the daily basis. Do you think they type the e-mails of the students one by
one? No. They use MS Word’s famous feature: Mail Merge.

Mail Merge feature of Word 2016 is used to combine data source, which
contains all the addresses with the main document. This definitely saves a
lot of time.

Let’s learn about this feature in detail.

MAIL MERGE

Mail Merge is a very efficient tool of MS Word. It is possible to write and
send a letter or email to multiple recipients at once using the Mail Merge
feature in Microsoft Word. From this tool, we & Let Me Answer
can create letters, mailing labels and envelopes | Have you ever received a circular
by combining main documents with a data | from your school on your e-mail id?

source.

Let’s know about two very important components of Mail Merge:

Main Document: It contains the text which we want to send to all the
recipients.

Data Source: It consists of personalised information such as name,
address, city, and phone numbers. This information is organised in the
tabular form with the field names.
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Creating the Main Document

Follow the following steps to create the main document.

1. Create a new —_—

document and
type a letter,
that you want to
send to multiple

iEF

addresses.

2. Click on the
Mailings tab.

3. Click on Start
Mail Merge drop-down arrow and select the Step-by-Step Mail Merge
Wizard Option.

Figure 4.1: Start Mail Merge

4. The Mail Merge pane appears on the right side of the window.

Follow the following steps to create the document.

1. Under the ‘Select document type’ section, select
the letters radio button.

Figure 4.2:
Selecting Document

2. Click the Next: Starting document under the
‘Step 1 of 6" section at the bottom of the task
pane.

3. Under the Select starting document section,

Figure 4.3: Selecting recipients click on the Use the current document option.
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4. Under the ‘Step 2 of 6" section, click the
Next: Select recipients.

There are three ways to create the Recipients
list:

1. Use Existing List: Select a list if you already
have one, then click “OK”

2. Select from Outlook contacts: Select a list
from the address book of Outlook.

3. Type New List: If you don't have a list, choose
this option to build a list to be combined
with your word document.

Figure 4.4: Type New List
CREATING THE DATA SOURCE

If there is no list, then we need to create a new list.

Figure 4.5: New Address List
Follow the following steps to create a New List.

1. Click on the create button.
2. 'The New Address List appears.
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Figure 4.6: New Address List

Follow the following steps to enter records.

1.

i »

To add values to the list, click on the New Entry button.
Fill in the information in the New Address List.

If you want to enter more records, click on the New Entry button.

Click on the OK button.

Give the appropriate name and click on the Save button.

Figure 4.7: Save Address List
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MERGING THE COMPONENTS OF MAIL MERGE

After creating the data source, merge both the components: Main Document

and Data Source together.
@ Let Me Answer
What do you mean by merging?

1. Select the records you want to merge and click OK.

Follow the following steps to merge these two.

Figure 4.8: Mail Merge Recipients

2. On the Mailings tab, click on the Insert Merge Field button to insert the
fields from the database.

Figure 4.9: Insert Merge Field Button
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.."“ °
<2 % Do You Know?

To insert a merge field, we can press
Alt + Shift + F Key combinations.

3. Select the field you intend to add and the
field name will appear in the document.

Figure 4.10: Insert Merge Field

VIEWING THE MERGED DATA

Follow the following steps to preview the merged data.

1. On the Mailings tab, click on the Preview Results button. Alternatively,
click the Next: Preview your letters under the “Step 4 of 6’ section.

Figure 4.11: Preview Results

2. 'The data stored in the fields will appear.

3. Once you've previewed the records, click on the Finish Merge button.
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Figure 4.12: Complete the Merge

PRINTING THE MERGED DOCUMENT

If you wish to directly print the letters then from the File tab, select the Print
Option.

Figure 4.13: Printing Merged Document
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If you intend to save the individual letters permanently and edit them later,

click on the Edit Individual Letters option.

REMEMBER IT!

| To print the merged document, Alt + Shift + M Key combinations can be used.

- 2 Kids’ 1IQ

Roshni wants to insert a merge field but she has forgotten the steps which her teacher
told to follow. Help her with a simple way for it.

' Let’s Recall

Mail Merge is a very efficient tool of MS Word which allows you to write and send
a letter or email to multiple recipients.

o Mail Merge consists of the main document and a data source.
o Main Document contains the text which we want to send to all the recipients.

 Data Source consists of personalised information such as Name, Address, City and
Phone number.

« Mail Merge saves time and typing efforts.
o Procedure you need to follow while using the feature of mail merging.
- Creating the main document.
- Creating the data source
- Merging the components of mail merge.
- Viewing the merged data.

- Painting the merged document.
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# Upskill Your Intellige

Fill in the blanks.

O feature of word 2016 is used to combine a data source with the
main document.

2. Two important components of Mail merge are .................... and ...

3 e, consists of personalised information.

4 e tab needs to be clicked in order to create the main document.

5. 'The Mail Merge Pane appears on the ......................... side of the window.

Answer in one word.

1. The tab which you select to execute the mail merge option.
2. Component of Mail Merge which contains the text we want to send to all

recipients.

Write ‘T’ for True statements and ‘F’ for False statements.

1. The two main components of a mail merge process is the main
document and data source.

2. Edit Individual letters option allows you to save the individual letter

permanently and edit them later.

S

3. To add values to the list, we click on the New Entry button.

4. Information in Data Source is organised in tabular form with the field names. O

5. You can select the list from the address book of outlook. D
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D. Identify and label the following buttons.

E. Answer the following questions.

1. What do you mean by Mail merge?
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A.

B X
O

4. How can we merge the Main document and Data source together?

ooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooo

ooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooo

ooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooo

ooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooo

')\ Critical Thinking

fo

Here are the steps to preview the merged data. Number them in order.
1. The data stored in the fields will appear. D

2. Once you've previewed the records, click on the Finish Merge button. D
3. On the Mailings tab, click on the Preview Results button. D

Its Samaira’s birthday. She has made a beautiful invitation using MS Word.
She wants to send a personal invitation to her friends without typing their
names and address again and again. Suggest her the way she can do this task.

Team Work

You are the head girl/head boy of your class. Create a data source of your
classmates which includes their personal information such as Name, Date of
Birth, Address, Phone numbers, and Parents’ names for the school identity
cards.

1. How many students are there in your class?
2. How many prints of student’s information are there?

3. How did you paste the logo of your school in the identity card?
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UPGRADING PRESENTATION

(o] JIEagning[outcomes
At the end of this chapter, students will be able to:
+ Insert the objects in the placeholder.
+ Add WordArt, SmartArt and Shapes in a presentation.
+ Do Animations and Transitions in a presentation.

Naman and Akhil have been told to complete the task. They have managed to do
so but are unable to tell the name of the software application. Now, it’s your turn
to join the dots to find the following software application.

AT N Ask students to name the above software application. Also, tell them to recall MS
PowerPoint application features which they learn in their previous class.

z\f Note:
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“Hello friends! Let us make our presentations
more engaging and powerful by adding WordArt,
SmartArt, shapes, animations and transitions.

As we already know, Microsoft PowerPoint is a software application that
allows you to create and show slides to support a presentation. In this chapter,
we will learn how to use the right effects on text

and objects to make our presentations more [‘MESMEMESAEEES

visually appealing and meaningful.

More than 500 million people
use PowerPoint worldwide.

ADDING OBJECTS IN A PRESENTATION

PlacehOIder Placeholders {.llfk o aad '|i'||i!‘
Click and begin

& Cliok he aeded R typing to add text

A placeholder is a region

surrounded by dotted

borders on a slide. The first

slide of a new presentation Clkaniconto
has two placeholders on it

by default.

Figure 5.1: Different Placeholders

Different types of
content, text and images
can be added in a
placeholder.

Placeholders

Figure 5.2: Placeholders




Follow the following steps to add text to a placeholder.
1. Move the cursor to the ‘Click to add title’ placeholder and click it.
2. Type the Title of the presentation in the placeholder.

3. Likewise, move the cursor to the ‘Click to add subtitle’ placeholder and
click it. Then, type the Subtitle of the presentation in the placeholder.

Figure 5.3: Adding Text in the Placehelder

Editing Text with WordArt @ Let Me Answer
WordArt is a feature that creates text effects L/1atdoyoumeanby WordArt?

which are not available through font formatting. Adding WordArt to the
slides makes them attractive.

Figure 5.4: Inserting WordArt
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Follow the following steps to insert WordArt.
1. Select the text in the placeholder.

2. Click the Format tab. Click the drop-down arrow next to the WordArt
styles.

3. A list of WordArt styles will appear, click on the desired style.

Figure 5.5: WordArt Styles Group Figure 5.6: WordArt Styles Preview

4. Observe the change in the text.
Follow the following steps to apply the text effects.

1. Select the text in the placeholder.

Figure 5.7: Applying Text Effects
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2. Click the Format tab. In the WordArt Styles group, click the Text effects.

3. From the drop-down list box, select the desired text.

4. Observe the change in the text. T ——
] Which shapes are available in
Inserting Shapes MS PowerPoint?

In MS PowerPoint, a range of shapes are available that can be added to the
presentation. Adding shapes to the slides enhance the appearance of the
presentation.

Follow the following steps to insert shapes to a slide.
1. Click on the Insert tab.
2. Intheillustrations group, select the shapes button.

3. From the drop-down menu, select the shape you
want to add.

4. To draw the desired shape, click and drag the
mouse on the slide.

5. Release the mouse button.

6. 'The chosen shape will appear on the slide.

Figure 5.8: Inserting Shapes
Follow the following steps to rotate and resize a shape.

1. Click the shape you want to modity.

2. Sizing handles will appear on the corners, drag one
of them to get the desired size.

3. Similarly, move the rotating handle on the top to
rotate the desired shape.

Adding Text to a Shape

In PowerPoint, text can also be added to any shape.
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Follow the following steps to add text in a shape.

1. Select the shape in which you want to add the text.

2. Right-click on it, and a pop-up menu will appear.

3. Click on the Edit Text option and add text to the shape.

Inserting SmartArt

One of the features of PowerPoint is SmartArt. A SmartArt graphic is a visual
representation of information and ideas as well numeric values or data.

Follow the following steps to insert SmartArt.

1. Go to the slide where you
want the SmartArt graphic
to appear.

2. Click on the Insert Tab.

3. In the illustrations group, Figure 5.9: Insert Tab
select the SmartArt Button.

4. A dialogue box ‘Choose a SmartArt Graphic’ will appear.
5. Select the category and type from the list.

Figure 5.10: Applying SmartArt
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6. Double click on the desired
SmartArt to insert a graphic in
the slide.

7. The SmartArt graphic will
appear along with a text
placeholder.

8. Insert the text as you wish to.
Figure 5.11: Inserting SmartArt

ANIMATIONS AND TRANSITIONS

When you watch an animated film, the scenes keep coming one after the
other. Have you ever wondered why? This is because of the transitions. The

same effect can be done in a PowerPoint presentation also by slide transition.
.‘ o

Slide Transition €2 5 Do You Know?

Emile Cohl is referred to as the Father of
Transitions are animation effects which | the Animated Cartoon.

can be applied to slides. The way one slide follows the other on the screen
in a presentation is called transition. When a slide enters or exits during the
slide show, we may adjust the speed of each transition and even add sound.

Let us explore the transition styles found on the Transitions tab.

Subtle Transitions

Figure 5.12: Subtle

Exciting Transitions

Figure 5.13: Exciting
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Dynamic Content

Figure 5.14: Dynamic Content

Follow the following steps to apply slide transition.

1. Select the desired slide from the Slide Navigation pane on which you
want to apply the transition.

2. Click on the Transitions tab.
3. Click on the drop-down button to see all transitions.

4. Choose the transition effect of your choice.

Figure 5.15: Applying Transition
5. A preview of the transition effect appears in the slide area.

6. Click on Apply to all option from the Timings group.

Applying Animation to Text and Objects

Transitions and slide animations are similar, however, slide animations apply
to specific elements on a single slide- a title, chart, image, or individual bullet
point. Animation makes a presentation look attractive and eye-catchy.

Let us explore the four types of animations available.
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Entrance: These animations manage how an object enters a slide.

Figure 5.16: Entrance Effects

Emphasis: Specific contents are highlighted using these animations.

Figure 5.17: Emphasis

Exit: These animations manage how the object leaves the screen.

Figure 5.18: Exit

Motion Paths: When an object follows the designated path, these animations
are used to add animation.

Figure 5.19: Motion Paths

Follow the following steps to apply an animation to an object.
1. Select the desired object.

2. Click the Animations tab, and click on the More drop-down arrow to
view the available animations.

Figure 5.20: Animation Tab
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3. Select the animation effect from Entrance, Exit or Emphasis option.

Figure 5.21: Animation Preview

4. Click the preview button to preview the applied animation effect.

s Kids’ 1IQ

Saman has 50 photographs in a folder which she wants to add in all the slides . Further,
she wants to add animation effects to these slides. Suggest her the option to complete
this task.

! Let’s Recall

A placeholder is a region surrounded by dotted borders on a slide.
« Adding shapes to the slides enhance the appearance of the presentation.
 In PowerPoint, text can also be added to any shape.

« A SmartArt graphic is a visual representation of information and ideas as well
numeric values or data.

« Transitions are animation effects which can be applied to slides.
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¢ Upskill Your Intellig

A. Fill in the blanks.

1. PowerPoint is a software application that allows you to create and show slides

tosupporta ...
20 A is a region surrounded by dotted borders.
3. e, is a visual representation of information and ideas.
4. animation manage how the object leaves the screen.
50 e, is a feature that creates text effects which are not available

through font formatting.

B. Identify the following options in MS PowerPoint.

C. Answer in one word.
1. How many placeholders are there on the first slide of a new presentation?

D. Write ‘T’ for True statements and ‘F’ for False statements.
1. Text can be added to shapes. D
2. Transitions and slide animation are similar. D
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3. Entrance animations manage how the object leaves the screen. D
4. We can adjust the speed of each transition. D

5. Multiple animation effects can be applied to an object.
E. Answer the following questions.

1. What do you mean by Slide transition?

A. Naman has to make the food web diagram. For it, he wants to show the
relationship between different animals. He wants to display the same using
cycle form. Suggest him the ways to achieve the task.

B. Unscramble the letters to form correct words.
1. ELPACEHOOLR - oo
2. DILSE - e
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3. EEPSRTTANIO- e
4. XTTE- e
5. SSPHEA-

Find out the information on ‘COVID-19’ and make a presentation utilising all
the features learnt in Microsoft PowerPoint.
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PROGRAMMING IN SCRATCH

At the end of this chapter, students will be able to:
+ Sense input and its execution.

+ Use Mathematical Operations in Scratch.
+ Add the various blocks of the Control block.

Rahul wants to change the costume of the Sprite. Steps are given below but are
not in order. Arrange them in order to help Rahul.

From the list of costumes, select Dani-b costume.

2. Click on Choose a Sprite button on the bottom right side of the
Scratch window.

3. 'The sprite’s costume will be changed.

4. Select Dani Sprite to click on the Costume tab.

D00 O

‘¥ Teacher’s

Q\ Z Note: WEEEL the students in arranging the above steps in a chronological order.
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“Hello friends! Lets learn
about a few more blocks of
code in Scratch.

The various tasks that a sprite can carry out on the Scratch stage are already
known to us. We have also learnt how to change the background, colour,
direction, and costume of a Sprite. Let us now learn how to perform various
sensing and mathematical operations to solve a problem.

. = Do You Know?

Scratch service is developed by the MIT Media Lab, has been translated into 70+ languages, and is
used in most parts of the world.

SENSING INPUT AND ITS EXECUTION

The light blue colour-coded Sensing blocks are among the eight categories
of Scratch blocks. They are used to sense the keyboard input while executing
the script as well as the location of the mouse pointer and its distance from a
Sprite. Further, these blocks determine whether a Sprite is touching another
sprite. Hence, these blocks give your Sprites the ability to sense an action

that takes place.
at takes place %27 Let Me Answer

What do you mean by sensing?

Sensing a Mouse Click

When we click the right mouse button mouse down, the sensing block
responds. This implies that we can create a Sprite or part of our programme
in such a way that it would react to our activities.

This is another example of event-driven programming. When the mouse
button is clicked, the script runs.
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Sensing a Key

When a user touches a certain key on the keyboard key space pressed, this
block can be used to detect it.

§27 Let Me Answer
When Two Sprites Collide What do you mean by the term collide?

This is used to detect a sprite and respond to
contact with another Sprite on the stage. This
is done by telling the Sprite to do something
when one colour touches another colour.

Look at the code, it tells the Sprite to change
to the next costume when the colour red
touches the colour yellow.

Asking a Question

Figure 6.1: Responding to Contact
This block stores keyboard input in the answer

block while enabling us to put a question on
the screen. The question is displayed in a call-
out on the screen. While the user enters an
answer or presses the enter key, the application
waits.

USING OPERATORS Figure 6.2: Asking a Question

Operator blocks are light green-coloured coded blocks and
are round in shape. They are used to solve mathematical
equations. Basic mathematical operations, logical operations,

and different functions are all included in the operators group

blocks.

Let us perform calculations in a Scratch Project.
Steps: Figure 6.3:
1. Open a new file in the Scratch window. Operators
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2. Delete the cat sprite, and choose sprite from the library button.
Select the Crab sprite from the Animals category and click OK.

4. Drag the when flag clicked (crop from button file) block from the Events
block category and place it in the script area.

5. Take the say hello for 2 seconds(crop from button file) and say hello(crop
from button file) blocks from the Looks block category and place them
under the when flag clicked(crop from button file) in the script area.

6. Drag the - (crop from button file) block from the Operators block
category and club it inside the say hello block.

Type the text and numbers inside the block as shown in the figure.
Click the blocks to run the script.
Observe the Sprite displaying the calculations.

Figure 6.4: Sprite subtracting two numbers on the Stage

WORKING WITH VARIABLES

You may have noticed that when you progress to the next level in playing
computer games, your score either rises or falls and is displayed on the screen
at the end. These values are stored by using variables. A Variable is a name
given to a place in the memory of the computer. These values can be either
numbers or text.

REMEMBER IT!

With the Scratch app, users can snap together computer programming blocks to make
interactive stories, games, art, animations etc.
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Creating a Variable

Follow the following steps to create a variable.
1. In the block palette, click the variable category.
Select the Make a Variable button.

Name the variable.

B S

Use the options available.

Figure 6.5: Creating Variables

CONDITIONAL STATEMENT

Sometimes, we want to have programs that respond differently in different
situations. We might want the program to say ‘It's your turn, “You win’ or ‘you lose.
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In Scratch, ‘wait 1 seconds, ‘repeat 10, ‘if;, ‘forever if” or ‘if then” are the
conditional blocks present in the Control blocks category.

Wait 1 seconds block halts the script’s execution for some duration as
mentioned in the block.

Repeat 10 block repeats a set of instructions a specified number of times.

In if then block, the script inside it will execute, only if the condition given
after if is true. If the condition is false, no code is executed.

The if else block checks the condition between if.. then, if it is true then block
place after if.. then will execute. If it is false, then the blocks placed after else
will be executed.

In forever block, a set of instructions keep repeating until the interrupting
button - the stop button - is pressed.

- 2 Kids’ 1IQ

Sam has written a statement in Scratch and he wants to repeat the statement at least 10
times. Suggest him the block by which he can complete this task.

@ Let’s Recall

The light blue colour-coded sensing blocks are among the eight categories of
Scratch blocks used to sense the keyboard.

o The category of Operators group blocks of basic arithmetic operations, logical
operation and various functions.

« A variable is a name given to a place in the computer’s memory.

o The if else block checks the condition between if .. then, if it is true then block
place after if..then will execute. If it is false, then the blocks placed after else will be
executed.

« In forever block, a set of instructions keep repeating until the interrupting button
- the stop button - is pressed.
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# Upskill Your Intellige

Fill in the blanks.

1. Sensing blocks are of ........................ colour.

2. Operator blocks are ........................ in shape.

3. When we click the ..................... mouse button, the sensing block responds.
4. 'The question is displayed ina ........................ on the screen.

......................... blocks are used to solve mathematical equation.

Write ‘T’ for True statements and ‘F’ for False statements.

1. Sprites can react to our activities. D
2. A variable is a name given to a place in the memory of the computer. D
3. Stop all block stops the execution of a script. D
4. Forever block repeats a set of instructions a specified number of times. D
5. Say hello block is in Looks block category:. D
Match the following.

1. Sensing blocks Light-green colour

2. Operator blocks In Events blocks

3. When Flag clicked block Script execution stops for a specified time
4. Wait block Light-blue colour

Answer the following questions.

1.

Computer-5

Write the steps to create a variable.
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2. What do you mean by conditional statement?

Harmeet has created a program in Scratch and she wants her Sprite to repeat
a set of instructions forever. Recommend her the block to accomplish the task.

Team Work

Learn how to use different blocks that are accessible in Scratch and their diverse
functions.

1. What did you learn after the discussion?

2. Conclude your points as a project on a word file.
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At the end of this chapter, students will be able to:

+ Know the features of Excel.

+ Enter data and Perform calculations in a Worksheet.

+

Learn types of data.
Save a workbook.

‘

Ram has got the marksheet for his first term examinations. He has to calculate
his total marks. Help him to do the task.

English
Hindi 75
Maths 79
Science 72
Social Studies 65
Computer 77
Total

19

20

17

15

18

100

100

100

100

100

‘¥ Teacher’s

Apprise the students that in the above activity, text and numbers have been organised

would have been very easily done in Microsoft Excel by applying simple formulas.

2\ N PYTYR  in rows and columns which can be defined as a Spreadsheet. Also, inform them this task
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“Hello friends! Let’s learn
about the MS Excel and
its various type of data
features. Lets learn to
enter them data into it.

Microsoft Excel is a popular spreadsheet. A spreadsheet can be defined as
text and numbers that have been organised in rows and columns. It is widely
used to perform mathematical calculations. It Fp-a o

; . &% Do You Know?
also provides features such as formulas, functions

. . . Excel was the first software that

and data analysis tools that make it easier to deal | . i odquced a toolbar
with a large amount of data.

theil 4

il

Figure 7.1: Microsoft Excel
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FEATURES OF MS EXCEL 2016
Excel has built-in formulas and functions to do calculations.
Easy data entry and sorting of data.
Searching and replacing data can be quick.

When we make a change atone place in a worksheet, the entire spreadsheet
is automatically recalculated.

Data can be represented in charts and graphs for comparing the data
effectively.

By using the Auto Fill option, quick data entry can be done in a large
series of cells.

Let us learn how to Start MS Excel 2016.

Starting Excel 2016

Follow the following steps to start MS Excel 2016.
1. Click on the Start button.

Scroll down to find Excel 2016.

Click on it.

B S

The Excel 2016 window appears.

Figure 7.2: Starting Excel Figure 7.3: Excel Window
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COMPONENTS OF MS EXCEL 2016 WINDOW

Cell

A cell is an intersection of rows and columns. It is the smallest unit in a
worksheet and text, as well as numbers, can
be written in it. Each cell has its unique cell
address identified by its column letter and
row number.

@ Lat Me Answer

State the difference between a remote’s
cell and a cell in Ms Excel.

Cell Address

Cell

Figure 7.4: Cell

Worksheet

A worksheet in Excel is a
collection of cells organised
into rows and columns. A single
worksheet has 1,048,576 rows
and 16,384 columns.

Figure 7.5: Worksheet
Workbook

An excel is called a workbook.

By default, the file name of

a new workbook is Book 1.

There are many worksheets in a

single workbook. We can edit,

delete, hide and rename these ;
worksheets. I p—

Figure 7.6: Workbook
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Components of a Worksheet

|
N

Address Bar 1 Title Bar
Cell Address i
Formula Bar
Column Heading
9 Active Cell
Row Heading
Sheet Tab Status Bar o Scroll Bar

Figure 7.7: Excel Worksheet Layout

Title Bar: Located at the top of the Excel window, it displays the name
of the currently opened Workbook.

Address Bar: It shows the address of the active cell.

Sheet Tab: It is present at the bottom left side of the Excel window. It
shows the number of worksheets in a workbook and the active sheet.
By default, the names of the worksheets are sheet 1, sheet 2 and so on.
Active Cell: The cell which is currently selected and surrounded by a
thick black border. The data can be typed into an active cell only.
Horizontal Scroll Bar and Vertical Scroll Bar: They are used to scroll
the worksheets up and down or left and right to view the entire sheet.
Formula Bar: The contents of the active cell is shown here. Data or
formulas can be typed or edited in the formula bar.

Status Bar: It is present at the bottom of the Excel window. It displays
the name of the selected command or status information.
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8. Columns Heading: Vertical section of the table which is numbered
with alphabetic values such as A, B, C AND SO ON. Each column has
its identification with its column number such as A1, A2,..and so on.

9. Rows Heading: Horizontal section of the table which is numbered with
numeric values such as 1,2,3... and so on.

10. Cell Address: Cell Address shows the column letter and row number
of each cell. For example, D3 is the cell address referring to the cell with
column D and row 3.

REMEMBER IT!

Microsoft considered many other names before finally landing on Excel. Other serious
considerations were “Mr. Spreadsheet” and “Master Plan”.

CREATING A NEW WORKSHEET

Follow the following steps to create a New Worksheet.

1. Click on the File tab. A
backstage view appears.

2. Click on New, and a blank
workbook will be displayed
with Sheet 1 as Default

Worksheet. .

DATA ENTRY

Figure 7.8: Workbook

Follow the following steps to enter the data in MS Excel.
1. Click on the cell.

2. Type the text or numbers.

3. Press the Enter key.
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TYPES OF DATA

Three types of data can be entered in a Microsoft Excel Worksheet.

1. Numbers: Values that have numerals from 0 to 9 and the characters like +,-,!
and many more. These can be used in calculations. By default, numbers are
right aligned in a cell.

2. Text: Text can contain datalikealphabets, numbers, spaces and special characters.
It is not used in calculations. By default, the text is left aligned in a cell.

3. Formulae: It is a mathematical equation which calculates the value of the cell.
They can range from basic calculations to complex calculations. Remember:
Formulae begin with an equal to (=) sign

Doing Calculations in a Worksheet

The most efficient feature of MS Excel is to perform calculations by creating
formulae. Formulas perform mathematical calculations on the data values
stored in a worksheet. The result of the calculation is displayed in the cell
where the formula is entered.

Symbol

Addition + Plus
Subtraction - Minus
Multiply * Asterisk
Divide / Forward Slash

We can use simple or complex
mathematical formulas or
formulae in Excel.

In the example given below,
formulae will be applied to do
the addition of values. Formula
= (C3+D3+E3) and press enter.

Formula is entered is cell F3. Figure 7.9: Excel Formula
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SAVING A WORKBOOK

Follow the following steps to save a workbook.
1. Click on the File tab.

2. Select the option Save or Save As.

Figure 7.10: Browse Option

OPENING A WORKBOOK

Follow the following steps to open a saved workbook.

1. Click the File tab.

2. Click the Open option, and the open dialogue appears.

Figure 7.12: Open Option Figure 7.13: Open Dialog Box
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3. Browse and navigate to the folder to open the saved workbook.
4. Select the file and click on the Open button.

CLOSING A WINDOW

Follow the following steps to close the Workbook.
1. Click the File tab.
2. Clickonthecloseoption.

3. The current workbook
will close.

The above steps will close the

workbook, but to close the
Excel window click on exit or

press Alt + F4. Figure 7.14: Closing a Workbook

- = Kids’ 1Q

Raman has to enter the formula for calculating the marks. He doesn’t remember the
sign he needs to add before writing the formula. Suggest him the sign by which he can
use.

! Let’s Recall

A cell is an intersection of rows and columns.
« A worksheet in Excel is a collection of cells organised into rows and columns.
« An excel is called a workbook.
o By default, the text is left aligned in a cell.

o The most efficient feature of MS Excel is to perform calculations by creating
formulae.
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}%kiu Your Intellig

A. Fill in the blanks.

1.

2
3
4.
5

Microsoft Excel is a popular ..........................

Excel has built-in formulas and functions to do .........................

A cell is an intersection of ........................ and ..o

A single worksheet has ....................... rows and ... columns.

The cell which is currently selected and surrounded by a thick black border is
called ...

B. Label the components of the MS Excel Window.

[y

alermil =

C. Write ‘T’ for True statements and ‘F’ for False statements.

1.

2
3
4.
5

Formulae is a mathematical equation which calculates the value of
the cell.

Two types of data can be entered in a Microsoft Excel worksheet.

The file in excel is saved with an extension .xIsx.

To close the Excel window, we press Alt + F3.

L)
()
There is a single worksheet in a workbook. D
()
]
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D. Answer the following questions.

1. Write any three features of MS Excel 2016.

p\ Critical Thinking

W

Shobhit has entered the name of the students from cell B1 TO B6. Now, he is
unable to recognise the column heading. Help him in identifying the column
heading in the cell range B1 to B6.

Team Work

Find out your stationery expenses on a daily basis and represent it in MS Excel
for two months. Calculate the total expenses in a week and a month.
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Take your turn and play the game.

-

Tiles which
Full form of show frequently

Denoting a
character above

RAM updated the baseline.

information.

It helps us to
improve our
vocabulary by
providing a list of
synonyms.

- ——
A name given In which app a

to a place in the formula starts with
computer’s memory. equal ‘=" sign?

Four types of

animations.
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Reach the highest level.

& ¢

Computer-5

G050

The direction in
which a document
is displayed.

In this construct,
step by step
instructions is

followed.

[ provide faster
and easier data
entry and sorting
of data.
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